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ABSTRACT 

 

 Reporting service manages run time and administrative aspects of reporting for 

IBM Information Server. IBM information server is the industry’s first comprehensive, 

unified foundation for enterprise information architectures. It is built entirely on a set of 

shared services that centralize core tasks such as security, user administration, logging, 

and reporting. IBM Cognos 8 BI provides many facilities. One of these facilities is 

Report Studio. With Report studio we can create many types of reports in different output 

formats that meet the industrial requirements. Reporting Service allows integrating an 

external reporting engine to create, execute, modify and perform all the administrative 

reporting operations.  
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1. Introduction 

IBM Information Server is the industry’s first comprehensive, unified foundation 

for enterprise information architectures, capable of scaling to meet any information 

volume requirement so that companies can deliver business results within these initiatives 

faster and with higher quality results IBM Information Server helps user understand 

existing data sources, cleanse, correct, and standardize information, and load analytical 

views that can be reused throughout the enterprise. 

 It is built entirely on a set of shared services that centralize core tasks across the 

platform. These include administrative tasks such as security, user administration, 

logging, and reporting. Shared services allow these tasks to be managed and controlled in 

one place, regardless of which product module is being used. The shared services, 

otherwise known as common services, also include the metadata services, which provide 

standard service-oriented access and analysis of metadata across the platform.  

One of the common services is Reporting service, which manage run time and 

administrative aspects of reporting for IBM Information Server. The user of Information 

Server can create product-specific reports for WebSphere DataStage, WebSphere 

QualityStage, and WebSphere Information Analyzer, Business Glossary and cross-

product reports for logging, scheduling, and security services. All reporting tasks are set 

up and run from a single interface, the IBM Information Server Web console. The user 

can retrieve and view reports and schedule reports to run at a specific time and frequency. 

User defines reports by choosing from a set of predefined parameters and templates. 

Reports can be formatted as HTML, PDF or Microsoft® Word documents. 

Reporting Service allows integrating an external reporting engine to create, 

execute, modify and perform all the administrative reporting operations. For integration, 

reporting service provides a Service API which has to be implemented for the specific 

reporting engine. The aim of this project is to implement the reporting engine provider 

API for IBM Cognos reporting engine and integrate it with the IBM Information Server. 

This exercise includes understanding of IBM Cognos ReportNet, understanding the IBM 

Information Services Framework and developing same SOA Services, developing and 
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executing the reports with sample data, implementing the IBM Reporting Service 

Provider API for Cognos ReportNet, deploying reports in IBM Information Server, and 

executing the reports. 
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2. IBM Cognos BI 

2.1 Cognos 8 Architecture 

 Cognos 8 has a multi-tiered architecture. It can be separated into three tiers: 

1. Web server 

2. Applications 

3. Data 

  The tiers are based on business function, and are separated by network firewalls. 

 

Figure 1: IBM Cognos 8 Architecture 
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User Interfaces 

Cognos 8 has Web-based and Windows-based user interfaces. 

Web-based interfaces  Windows-based interfaces 

 

  

 

 

 

 

Web-based User Interfaces: 

a) Cognos Connection:    

 Cognos Connection provides a single access point to the corporate data available 

for its products. It provides a single point of entry for querying, analyzing, and organizing 

data, and for creating reports, scorecards, and events. Users can run all their Web-based 

Cognos 8 applications through Cognos Connection. Other business intelligence 

applications, and URLs to other applications, can be integrated with Cognos Connection.       

 In addition to selections for viewing data and creating objects, Cognos 

Connection includes 

 portal pages        

             The new page button opens a wizard where users can create a customizable page             

that uses portals to show different types of content at the same time.  

 Public Folders        

            Public Folders store shared Cognos 8 content, such as packages, reports,             

agents, shortcuts, and jobs.    

1. Cognos Connection 

2. Cognos Administration 

3. Query Studio 

4. Report Studio 

5. Analysis Studio 

6. Event Studio 

7. Metric Studio                            

                                                                                                                                                               

1. Framework Manager 

2. Metric Designer 

3. Transformer 

4. Map Manager 

5. Cognos 8 Go! Office 
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 My Folders       

      My Folders store personal Cognos 8 content, such as reports, shortcuts, and jobs. 

 Link to tools and applications     

            The Launch button provides links to the Cognos 8 studios, Drill-through             

Definitions, which are used to navigate through related data when querying or             

analyzing data, and Cognos Administration. 

b) Cognos Administration: 

 Cognos Administration is a central management interface that contains the 

administrative tasks for Cognos 8. It provides easy access to the overall management of 

the Cognos environment and is accessible through Cognos Connection. 

 Cognos Administration is organized into three sections: 

1. Status 

                 Use the links in this section to monitor activities, server status, and system                  

metrics, and change some system settings. 

2. Security 

       Use the links in this section to define users, groups, and roles for security purposes, 

configure capabilities for the interfaces and studios, and set properties for the user 

interface profiles that are used in Report Studio. 

3. Configuration 

            Use the links in this section to set up data source connections, deploy Cognos8 

content from one content store to another, create distribution and contact lists,  add 

printers, set styles, manage portals and portal layout, start or stop dispatchers  and 

services, and change system settings. 
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c) Query Studio: 

 Query Studio lets users with little or no training quickly design, create and save 

reports to meet reporting needs not covered by the standard, professional reports created 

in Report Studio. 

d) Report Studio: 

 Report Studio lets report authors create, edit, and distribute a wide range of 

professional reports. They can also define corporate-standard report templates for use in 

Query Studio, and edit and modify reports created in Query Studio or Analysis Studio. 

e) Analysis Studio: 

 In Analysis Studio, users can explore, analyze, and compare dimensional data. 

Analysis Studio provides access to dimensional, OLAP (Online Analytical Processing), 

and dimensionally modeled relational data sources. Analyses created in Analysis Studio 

can be opened in Report Studio and used to build professional reports. 

f) Event Studio: 

 In Event Studio, user set up agents to monitor users data and perform tasks when 

business events or exceptional conditions occur in users data that must be dealt with. 

When an event occurs, people are alerted to take action. Agents can publish details to the 

portal, deliver alerts by email, run and distribute reports based on events, and monitor the 

status of events. For example, a support call from a key customer or the cancellation of a 

large order may trigger an event, sending an email to the appropriate people. 

g) Metric Studio: 

 In Metric Studio, user can create and deliver a customized score carding 

environment for monitoring and analyzing metrics throughout users organization. Users 

can monitor, analyze, and report on time-critical information by using scorecards based 

on cross-functional metrics. 
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Windows-based User Interfaces: 

 The Windows-based Cognos 8 interfaces are the modeling components: 

Framework Manager, Metric Designer, Transformer, and Map Manager. 

a) Framework Manager : 

 Framework Manager is the Cognos 8 modeling tool for creating and managing 

business-related metadata for use in Cognos 8 analysis and reporting. Metadata is 

published for use by reporting tools as a package, providing a single, integrated business 

view of any number of heterogeneous data sources. OLAP cubes are designed to contain 

sufficient metadata for business intelligence reporting and analysis.  

b) Metric Designer: 

 Metric Designer is the Cognos 8 modeling tool used to create extracts for use in 

Cognos 8 score carding applications. Extracts are used to map and transfer information 

from existing metadata sources such as Framework Manager and Impromptu Query 

Definition (.iqd) files. 

c) Cognos 8 Go! Office: 

 Cognos 8 Go! Office allows users to access Cognos reporting data directly within 

Microsoft Office applications. Cognos 8 Go! Office makes use of the Microsoft .NET 

Framework to allow clients to interact with server-based components.  

 Cognos 8 Go! Office provides two types of clients: 

1. The smart client provides a zero-administration client with a zero-deployment 

impact.   Product updates are automatically captures though the smart client. 

2. The COM add-in client requires a client installation. Product updates are 

delivered by uninstalling and reinstalling the COM add-in client. 
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d) Transformer: 

 Cognos 8 Transformer is the Cognos 8 modeling tool used to create PowerCubes 

for use in Cognos 8. Secured Cognos 8 PowerCubes are not compatible with Cognos 

Series 7. 

e) Map Manager: 

 Administrators and modelers use a Windows utility named Map Manager to 

import maps and update labels for maps in Report Studio. For map features such as 

country and city names, administrators and modelers can define alternative names to 

provide multilingual versions of text that appears on the map. 

Tier 1: Web Server 

 The Cognos 8 Web server tier contains one or more Cognos 8 gateways. Web 

communication in Cognos 8 is typically through gateways, which reside on one or more 

Web servers. A gateway is an extension of a Web server program that transfers 

information from the Web server to another server. 

 Cognos 8 supports several types of Web gateways 

1. CGI 

CGI is the default gateway, it can be used for all supported Web servers.  

2. ISAPI 

ISAPI can be used for the Microsoft Internet Information Services (IIS) Web 

server. It delivers faster performance for IIS. 

3. Apache_mod 

 User can use an apache_mod gateway with the Apache Web server. 

4. servlet 
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 If users Web server infrastructure supports servlets or user are using an              

application server, user can use a servlet gateway. 

Working of Cognos 8 gateway 

 When a Cognos 8 gateway receives a request, it 

1. encrypts passwords to ensure security 

2. extracts information needed to submit the request to a Cognos 8 server 

3. attaches environment variables for the Web server 

4. adds a default namespace to the request to ensure that the server authenticates 

the user in the correct namespace 

5. passes requests to a Cognos 8 dispatcher for processing 

Tier 2 : Applications Cognos 8 Servers 

 The Cognos 8 applications tier contains one or more Cognos 8 servers. A Cognos 

8 server runs requests, such as reports, analyses, and queries that are forwarded by a 

gateway. A Cognos 8 server also renders the Cognos Connection and Metric Studio 

interfaces. 

 Each Cognos 8 installation includes 

1. Application Tier Components, which include a dispatcher that operates 

services and routes requests 

2. Content Manager which manages Cognos 8 information 
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Figure 2: Cognos 8 Server 

Dispatcher 

 The dispatcher starts all Cognos 8 services configured and enabled on a computer, 

and routes requests. The dispatcher is a multithreaded application that uses one or more 

threads per request. The dispatcher can route requests to a local service, such as the report 

service, presentation service, job service, or monitor service. A dispatcher can also route 

requests to a specific dispatcher to run a given request. Requests can be routed to specific 

dispatchers based on load-balancing needs, or package or user group requirements. 

Content Manager 

 Content Manager is the Cognos 8 service that manages the storage of customer 

application data, including security, configuration data, models, metrics, report 

specifications, and report output. Content Manager is needed to publish models, retrieve 

or store report specifications, manage scheduling information, and manage the Cognos 

namespace. Content Manager stores information in a content store database, which is 

located in Tier 3 of the architecture. 

Application tier components 
Dispatcher 

Services 

Cognos 8 Services 

Access 
Manager 

Content Manager 
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The information stored by Content Manager includes 

 Reports 

             Reports contain specifications, properties, security settings, and outputs. This              

includes analyses created in Analysis Studio, queries created in Query Studio, and reports 

created in Report Studio. 

 Report packages 

              Packages contain metadata, reports, and folders. 

 Metric packages 

              Metric packages contain metadata, scorecards, and folders. 

 Agents 

              Agents include the conditions, schedules, and tasks used to monitor events and 

deliver notifications. This includes the list of recently detected instances of an event. 

 Server configuration 

        Server configuration contains directory information, the Cognos namespace and 

information about contacts, distribution lists, data sources, and printers. 

 Personal user information 

 Personal user information consists of My Folders and My Pages. 

 Language information 

              Language information includes names, descriptions, and tool tips in different 

languages to support Cognos 8 multilingual capabilities. 

Access Manager 

 Access Manager is the primary security component of Cognos 8. It provides 

Cognos 8 with a consistent set of security capabilities and APIs, including user 



University of Hyderabad 12 IBM India Software Labs 

authentication authorization and encryption. It also provides support for the Cognos 

namespace. 

Tier 3: Data 

The Cognos 8 data tier contains  

 Content store  

 Data sources  

 Metric store  

Content Store 

 The content store is a relational database that contains data that Cognos 8 needs to 

operate, such as report specifications, published models, and the packages that contain 

them; connection information for data sources; information about the external 

namespace, and the Cognos namespace itself; and information about scheduling and 

bursting reports. The relational database can be Cognos Content Database or a database 

from a supported third-party vendor. 

 Cognos 8 includes the Cognos Content Database as a default content store. User 

can use the Cognos Content Database as users content store, or user can use other 

databases, such as Microsoft SQL Server, Oracle, IBM DB2, or Sybase. Content 

Manager uses a JDBC API to access the content store and metric stores. 

 Much of the information in the content store, such as report results and XML 

report specifications, is stored as binary large object (BLOB) fields. Report results in 

other formats, such as HTML, XML, and CSV (comma separated values), are stored in 

compressed form and are uncompressed by Content Manager before they are sent to a 

user. 
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Cognos Content Database 

Cognos Content Database is an instance of an Apache Derby database that can be 

optionally installed and used as the default content store. Cognos Content Database can 

be used where user do not want to implement a commercial database for the content 

store. 

Data Sources 

Data sources, also known as query databases, are relational databases, 

dimensional cubes, files, or other physical data stores that can be accessed through 

Cognos 8. Application Tier Components use data source connections to access data 

sources. 

Metric Store 

A metric store is a relational database that contains content for metric packages. A 

metric store also contains Metric Studio settings, such as user preferences. More than one 

metric store may be created. For example, one metric store may contain content for a 

sales application and another metric store may contain content for a finance application. 

2.2 Building Cognos 8 Applications 

 

 

 

Figure 3: Building Cognos 8 Applications  

Locate and prepare data sources and models: 

 Cognos 8 can report from a wide variety of data sources, both relational and 

dimensional. 

Locate and 
prepare Data 
sources and 
Modules 
 

Build and 
Publish the 
Content 

Deliver the 
Information 
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 Database connections are created in the web administration interface, and are used 

for modeling, for authoring and for running the application. To use data for authoring and 

viewing, the business intelligence studios need a subset of a model of the metadata 

(called a package). The metadata may need extensive modeling in Framework Manager. 

Build and publish the content 

 Reports, scorecards, and so on are created in business intelligence studios of 

Cognos 8. Which studio user use depends on the content, lifespan and audience of the 

report, and whether the data is modeled dimensionally or relationally. Report Studio 

reports and scorecards are usually prepared for a wider audience, published to Cognos 

Connection or another portal, and scheduled there for bursting, distribution, and so on. 

User can also use Report Studio to prepare templates for self-service reporting. 

Deliver and view the information 

 User delivers content from the Cognos portal or other supported portals, and view 

information that has been saved to portals, or delivered by other mechanisms. User can 

also run reports, analyses, scorecards, and so on from within the business intelligence 

studio in which they were created. 

2.3 Cognos 8 request flow 

 Request flow describes internal Cognos 8 responses to user requests. In general, 

browser requests go through the Cognos 8 Web gateway and are sent to a dispatcher. 

Before any processing is performed by the dispatcher, the request is validated by Cognos 

Application Firewall. A passport is attached to each request as a record of a valid user 

session. 
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Accessing Cognos 8 

 

Figure 4: Accessing Cognos 8 

When a user requests authenticated access to Cognos 8, the following occurs: 

 1. When the user attempts to access the Cognos 8 Welcome page or any other 

Cognos 8 user interface from a Web browser, a request will be generated.  

 2. The gateway accepts the request and sends it to a dispatcher. 

 3. The dispatcher notes that there is no passport attached to the request and sends 

the request to Content Manager. 

 4. Content Manager sends the request to Access Manager. 
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 5. Anonymous access is disabled in this Cognos 8 system, so Access Manager 

sends the request back to Content Manager with a fault attached. The fault contains 

information about what is needed to log on. 

 6. Content Manager returns the request with the attached fault to the dispatcher. 

 7. The dispatcher sends the request to the presentation service. 

 8. The presentation service creates the appropriate logon page for the user, and 

returns the page through the dispatcher and the gateway to the user. 

 9. The user enters the required information, such as a user ID and password. The 

information is attached to the original request and sent through the gateway to the  

dispatcher. 

 10. The dispatcher sends the request to Content Manager. 

 11. Content Manager sends the request to Access Manager. 

 12. If all the required information is correct, Access Manager issues a passport, 

attaches it to the original request, and sends the request back to Content Manager. If the 

required information is incorrect or incomplete, then the request faults back to step 9. 

 13. Content Manager sends the request to a dispatcher. 

 14. The dispatcher processes the request and sends it to the presentation service. 

 15. The presentation service sends the Welcome page back through the dispatcher 

and the gateway to the user. 
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Running a Report  

 

Figure 5: Running reports 

 When a user runs a report or analysis through Cognos Connection, the following 

occurs: 

 1. The user clicks a report or analysis to run it, and the request goes through the 

gateway and the dispatcher to the presentation service. 

 2. The presentation service sends the request to the report service through the 

dispatcher. 

 3. The report service requests the report or analysis and metadata from Content 

Manager, through the dispatcher. 
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 4. Content Manager sends the report or analysis XML specifications and metadata 

to the report service. Content Manager refreshes metadata only when Cognos 8 is stopped 

and restarted or the model is updated and republished. 

 5. The report service returns one of these results to the presentation service: 

 an error page 

 a not ready page 

 a page of an HTML report or analysis 

 6. The presentation service sends one of these results through the dispatcher and 

gateway to the browser: 

 an error page 

 a wait or cancel page 

 a page of a completed HTML report or analysis in the Cognos Viewer 

interface 
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Overview of Cognos 8 for Reporting 

      Plan                 Install, Configure           Model and          Author          View 

      and Administer              Package 

 

 

 

 

 

 

 

Figure 6: Cognos 8 Overview 

Configure 
 Cognas 8 

Plan for 
 

Install 
 Cognas 8 

Setup and 
maintain  

Make reports  
Availability 

Create a  
Model 

Publish 
Package 

Author 
 reports 

View  
Print Reports 



University of Hyderabad 20 IBM India Software Labs 

3. IBM Cognos installation and configuration 

 

 

  

Figure 7: IBM Cognos installation and configuration 

1. Install Cognos 8 components. 

2. Set up the environment by installing or configuring third-party products. 

3. Configure Cognos 8 properties using Cognos Configuration. Some tasks may 

require that user also configure properties for third-party products. 

4. Start the Cognos services. 

5. Test users Cognos 8 product by using the test feature in Cognos Configuration 

and performing one or two simple tasks. 

Installing Cognos 8 

1. Install Cognos 8  

2. Check the default settings  

3. Create the content store database  

4. Set up the database client  

5. Update the Java environment  

6. Configure the Web server  

7. Configure the Web browsers  

8. Configure a user account  
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Start  
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University of Hyderabad 21 IBM India Software Labs 

9. Set the database connection properties for the content store  

10. Start the services  

11. Test the installation and configuration  

12. Finish the configuration  

Install Cognos 8  

Install Server Components 

 Install server components of Cognos 8. If user wants to use Cognos Content 

Database       as users content store, user must select it in the installation wizard. 

Install the Cognos 8 Samples 

       The Cognos 8 samples illustrate product features and technical and business best 

practices. User can also use them for experimenting with and sharing report design 

techniques, and for troubleshooting. 

Install Framework Manager 

     Install Framework Manager, the metadata modeling tool for Cognos 8 for 

reporting. 

Create the Content Store database 

 The content store is a database that Content Manager uses to store global 

configuration data, global settings connections to data sources, and product-specific 

content. Design models and log files are not stored in the content store.  
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1. Set the appropriate environment variables for DB2. 

Environment Variable   Description 

 

 

 

 

 

       

 

 

 

 

 

 

 

2. Determine if the database is Unicode by typing the following at the command 

prompt:       db2 get database configuration for database_name the codepage is 

Unicode if it has a value of 1208. 

3. If the codepage is not Unicode, create a new database that has a codepage value of 

1208. 

4. Create a buffer pool with a page size of 32k. 

The top level directory that 

contains the database client 

software or the entire database 

installation. 

DB2DIR 

The load library path. User must 

add driver location. Library Path 

The default database server 

connection. 

DB2INSTANCE 

Setting this optional environment 

variable to a value of 1208 

provides support for multilingual 

databases. 

DB2CODEPAGE 
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5. Create a system temporary tablespace with a page size of 32k. 

6. Create a user temporary tablespace with a page size of 4k. 

7. Global temporary tables will be created in the user temporary tablespace. 

8. Create a regular user tablespace with a page size of 4k. 

9. If user already created the content store and are now creating a logging database, 

create an additional regular user tablespace with a page size of 8k. 

10. Determine which user account Cognos 8 will use to access the database. 

11. Grant creates and drop table privileges on the database to the user account. 

Set up the database client 

1. Install the DB2 client software on the appropriate computers. 

2. If the content store is on a different computer from Content Manager, configure a 

database alias to the content store by running the DB2 Client Configuration 

Assistant. 

3. On Windows, stop the DB2 services and the HTML Search Server. 

4. To copy the JDBC2 driver, copy the DB2_installation/sqllib/java/db2java.zip file 

to the c8_location/userbapps/p2pd/WEB-INF/lib directory. 

5. Rename the db2java.zip file to db2java.jar. 

6. On Windows, restart the DB2 services and the HTML Search Server. 

7. Repeat this entire procedure on the Cognos 8 computers where the software must 

be installed. 

Update the Java Environment 

 Cognos 8 cryptographic services use a specific .jar (Java Archive) file, named 

bcprov-jdknn-nnn. jar, that must be located in users Java Runtime Environment (JRE). 
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This file provides additional encryption and decryption routines that are not supplied as 

part of a default JVM installation. 

1. Ensure that the JAVA_HOME environment variable is set to the JRE location. 

For example, to set JAVA_HOME to the JRE files provided with the installation, 

the path   isc8_location/bin/jre/version. 

2. Copy the bcprov-jdknn-nnn.jar file from the c8_location/bin/jre/version/lib/ext 

directory to theJava_location/jre/lib/ext directory. 

Configure the Web server 

 To use Web pages generated by Cognos 8, user must configure Web server. User 

must set up virtual directories, also known as Web aliases, for the directories that contain 

the HTML and Web files for Cognos 8. The virtual directories must be created to connect 

to the Cognos 8 portal and for client applications to be able to connect to the server. 

Create the following virtual directories: 

   Alias Location Permission 

Cognos 8 c8_location/userbcontent  Read 

Cognos 8/cgi-bin c8_location/cgi-bin Execute 

 

Configure the Web browser 

Cognos 8 uses the default browser configurations user must ensure that settings 

are enabled for cookies, activeX controls, java and Java scripts. 

Configure a user account 

The account under which Cognos 8 runs must: 

 have access to all required resources, such as printers and Web servers 

 have the rights to logon as a service and act as part of the operating system 
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 be a member of the local admin group 

Set the database connection properties for the content store 

1. On the computer where user installed Content Manager, start Cognos 

Configuration. 

2. In the Explorer window, under Data Access, Content Manager, right-click 

Content Store and click Delete. 

3. Right-click Content Manager, and then click New resource, Database. 

4. In the Name box, type a name for the resource. 

5. In the Type box, select the type of database and click OK. 

6. In the Properties window, provide values depending on users database type: 

7. If user uses a DB2 database, for the Database name property, type the database 

alias. 

8. If user want to change the logon credentials, specify a user ID and password: 

9. From the File menu, click Save. 

10. Test the connection between Content Manager and the content store. 

Start the services 

  To register the Cognos 8 service so that users can access it through 

Cognos Connection, user must start the services. Before user start the services, test the 

configuration by using the test feature in Cognos Configuration.  

Test the installation and configuration 

 Test the configuration settings by running the test feature. 

 Open a Web browser. 
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1. Test the availability of the dispatcher by typing 

       http://host_name:port/p2pd/servlet 

2. Open Cognos Connection by typing one the following, where cognos8 is the 

virtual directory user created when user configured the Web server. 

        http://host_name:port/cognos8 
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4.  IBM Cognos 8 Report Studio 

  Report Studio is a Web-based tool that professional report authors use to 

build sophisticated, multiple-page, multiple-query reports against multiple databases. 

With Report Studio, user can create any report that Users Company requires, such as 

invoices, statements, and weekly sales and inventory reports. 

Working in Report Studio 

 To create reports in Report Studio, first get familiar with the Report Studio 

environment. 

 Familiarize with the user interface. 

 Learn about basic report structure, which includes the layout and queries. 

 Learn how to work with report objects and different authoring modes. 

Figure 8: Cognos 8 Report Studio 
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The User Interface 

The Report Studio user interface has two panes, an explorer bar, and a work area to help 

user create reports. 

Insertable Objects Pane 

 The Insertable Objects pane contains objects that user can add to a report. User 

add objects to a report by dragging them to the work area. 

 The Insertable Objects pane contains these tabs: 

1. The Source tab contains items from the package selected for the report, such as 

data items and calculations. 

2. The Data Items tab describes the queries created in the report. 

3. The Toolbox tab contains a variety of objects that user can add to the report, such 

as text and graphics. 

Properties Pane 

          The Properties pane lists the properties that user can set for an object in a report. 

Explorer Bar 

 With the following buttons on the Explorer bar work with different parts of a 

report: 

 Pause the pointer over the page explorer button to go to a specific report page or    

prompt page. 

 Pause the pointer over the query explorer button to work with queries. 

  Pause the pointer over the condition explorer button to work with variables. 
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Page Layers Area 

 Use the Page layers area to create sections, or page breaks, in a report to show 

values for each member on a separate page.  

Context Filter Area 

 When working with dimensional data, use the Context filter area to filter users 

report to show values, or context, only for a specific data item. This technique is also 

known as a slicer filter.  

Work Area 

 The work area is where user designs reports. 

Visual Aids Button 

 The visual aids button provides options to help user when user are designing 

reports in the layout. 

Basic Report Structure 

 All reports have two components, a layout component that defines the report 

appearance, and a query component that defines report data. Understanding these 

components will help user design effective reports. 

Layout: 

 A layout is a set of pages that defines the appearance and formatting of a report. 

When user design the layout of a report, user 

 Present the data in a meaningful way by using lists, crosstabs, charts, and maps. 

 Give the report the appearance user want by adding formatting, such as borders, 

color, images, and page numbers. 

 Specify how the data flows from one page to the next page. 
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Pages: 

 Pages are containers for the layout objects that user use to build a report. A page 

is made up of the following mandatory and optional components: 

 page header (optional) 

 page body (mandatory) 

 page footer (optional) 

Objects: 

 Add layout objects to a page when user creates a report. Below are some of the 

objects that user will use often when building reports in Report Studio: 

List Add a list to show data in rows and columns. 

 cross tab 

 Add a crosstab to show data in a grid, with dimensions along the rows and 

columns, and measures in the cells or intersection points. 

 Chart  

 Map  

 Repeater 

       Add a repeater to show each instance of a certain column or data item in a 

separate frame. 

 Text 

 Block 

 Table 
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Queries: 

 Queries determine what data items appear in the report. Report Studio 

automatically creates the queries user need as user build reports. However, user can 

modify these queries or create users own custom queries to get the results user want. 

Working with Objects 

 User build reports by adding objects and manipulating them to obtain the results 

user want. To understand how to work with objects in Report Studio, user must be 

familiar with the following concepts: 

 object types 

 objects as containers 

 locking and unlocking objects 

 hierarchy of objects 

Object Types: 

 In Report Studio, layout objects are either inline or block. User can insert other 

objects on the same line as an inline object, but not on the same line as a block object. 

When user inserts an object to the left or to the right of a block object, the object appears 

on the line above or below the block object respectively. Examples of inline objects 

include graphics and text items.  

Objects as Containers: 

 Objects, such as tables, blocks, and any report frame, are containers in which user 

can insert other objects.  

Locking and Unlocking Objects: 

 To manipulate the contents of some objects, user must first unlock the object. 
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Authoring Modes 

 To meet the needs of both regular report authors and financial report authors, 

Report Studio provides distinct custom user interfaces that contain reporting features 

relevant to these roles. Access to each authoring mode is determined by the permissions 

user has to secured functions and features.  

Professional Authoring Model: 

 The Professional authoring mode gives users access to the full range of Report 

Studio functionality. In this mode, user can create any report type, including charts, maps, 

lists, and repeaters, using any data source (relational or multi-dimensional). It contains a 

superset of the features available in the Express authoring mode. However, user cannot 

view live data. 

Express Authoring Model: 

 The Express authoring mode provides a simplified and focused Report Studio 

interface. It is designed for non-technical users to create traditional financial and 

management statement reports. It only allows access to dimensionally-modeled data and 

uses a member-oriented data tree. This authoring mode allows user to see live data and 

supports only crosstab reports. It contains a subset of the features available in the 

Professional authoring mode. When user are in the Express authoring mode, if user open 

a report that was authored in the Professional authoring mode, user can see but cannot 

modify objects that can be inserted only in the Professional authoring mode, such as 

charts, maps, and lists. 

Creating a Report 

 When user creates a report, user is actually creating a report specification. The 

report specification defines the queries and prompts that are used to retrieve data, as well 

as the layouts and styles used to present the data. For simplicity, the report specification 

is named the report. 

Creating a new report involves 
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 specifying the package 

 choosing a report template 

 adding data items 

 saving the report 

 running the report 

a) Specify the Package: 

 Specify the package that will provide items for the report. The packages that user 

use to generate reports is based on models that are created in the modeling tool, 

Framework Manager. A model is a set of related objects, such as query subjects, 

dimensions, filters, and calculations. When user opens a package in Cognos 8, these 

model objects are visible in the left frame. 

Steps 

 In the Cognos Connection Welcome page, click the Launch link. from the drop-

down list, click Report Studio. 

 In the Select a package dialog box, click the package user want to use. 

 In the Welcome dialog box, choose whether to open a new or existing report or 
template. 

b) Choose a Report Template: 

 When creating a new report, choose a report template to get user started 

quickly. User can select a predefined template that is formatted as a particular 

report type, or user can open an existing report as a template. 

c) Add Data to a Report: 

 Select the data items that user want to appear in the report. Each object in the data 

source has a representative icon. User can insert all of the following objects in a report, 

except for packages and dimensions. 
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d) Save a Report: 

 Save user report to preserve the modifications user made. Reports are saved to the 

Cognos 8 server. User can also save user report on user computer. 

1. From the File menu, click Save, or click Save As to save a copy of the report 

under a different name. 

2. If user is saving the report for the first time, specify where user want to save the 

report and type a file name. 

3. Click Save. 

e) Run a Report: 

 Run report to see the data that is retrieved. 

Steps 

 Open the report that user want to run. 

 If user want to clear parameters values stored on the Cognos 8 server, from the 

File menu, click Clear Parameter Values. 

 From the Tools menu, click Validate Report. 

 If user requires more detail from the validation process, revalidate the report by 

clicking Validate with Options. 

 If user encounter validation errors and want Report Studio to identify incorrect 

objects in user report, from the Tools menu, click Auto Correct. 

 If user want to view only the tabular data, from the Run menu, click View Tabular 

Data  

 If user wants to set run options, from the Run menu, click Run Options. 

 Change any values user want for the current session and click OK. 
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 From the Run menu, click one of the options to produce the report in the format 

user want.  

 User can produce a report in HTML, PDF, CSV, various Excel formats, and 

XML. User cannot produce a report in CSV or XML format if user has more than one 

query defined in the report, unless the additional queries are used for prompts. 

f) Creating Report Templates: 

 A report template is a pattern user use to build reports. Create user own report 

templates when user frequently produce the same type of report.  

A template can include the following objects: 

 HTML items 

 Hyperlinks 

 Page numbers 

 Images 

 Tables 

 Text items 

 Blocks 

 Layout calculations 

 Date 

 Time 

To create a report template, user can 

 Create a new template 

 Convert a report to a template 
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Create a New Template 

1. From the File menu, click New. 

2. Click Query Studio Template and click OK. 

3. Pause the pointer over the page explorer button and click the report page or 

prompt page user want to format. 

4. In the Insertable Objects pane, click the Toolbox tab. 

5. Add the objects user want to the work area.  

6. Save the template. 

Convert a Report to a Template 

Convert a new or existing report to a template so it can be reused. 

 Create a new report or open an existing report. 

 Add the objects user want to the work area. 

 From the File menu, click Convert To Template. 

 From the File menu, click Save As to save the template as a new file and keep the 

original report intact. 

Types of Reports: 

 In Report Studio, user can create the following types of reports: 

 List 

 Crosstab 

 Chart 

 Map 
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1)  List Reports: 

 A list report is a report that shows data in rows and columns. List reports show 

detailed information from database. Each column shows all the values for a data item in 

the database or a calculation based on data items in the database. 

 The below list report USERS LIST shows the information of the users with ID, 

NAME, DEPARTMENT, SALARY, PHONE, and EMAIL as the columns. The report 

also gives the information about total number of users, their total salary, their average 

salary, minimum salary and maximum salary. 

 

Figure 9: Users List Report 
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Group Data: 

 Group data items in a list report to remove duplicate values. In addition to 

grouping, user can specify the sort order of data items. In lists, user can sort data items 

within groups as well as ungrouped items. 

1. Click the column user want to group on. 

2. From the Structure menu, click Group/Ungroup. A symbol appears indicating that 

the column is grouped. 

The USERS LIST is grouped on DEPARTMENT column. 

2)  Crosstab Reports 

 Crosstab reports show the data in rows and columns. Crosstab reports show 

information in a more compact form than in a grouped list. 

 

Figure 10: Users cross report 

 This is the crosstab report which gives the information about the SALARY of the 

users in each DEPARTMENT. 
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Single-Edge Crosstab Report: 

Single-edge crosstab report shows data in a list-like form. 

1. From the File menu, click New. 

2. Click Crosstab and click OK. 

3. In the Insertable Objects pane, on the Source tab, click the data item user want to 

add to the crosstab and drag it to Rows or Columns. 

4. Repeat step 3 to insert additional data items.  

 If user dragged the data item in step 3 to Rows, drag the additional items above or 

below the first item. If user dragged the data item in step 3 to Columns, drag the 

additional items to the left or right of the first item. 

5. To add measures to the crosstab, drag the measures user want to Measures. 

Nested Crosstab Report: 

 Nest data in a crosstab report to compare information by using more than one data 

item in a column or row. 

1. In the Insertable Objects pane, on the Source tab, click the data item user want to 

add to the report. 

2. Drag the data item to the location in which user want it to appear as a nested 

column or nested row. 

3. Repeat steps 2 to 3 to add other nested columns or rows. 

3)  Charts: 

 Report Studio can generate many types of chart reports, like  

 Column 

 Bar 
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 Pareto 

 Line 

 Pie, donut 

 Area 

 Combination 

 Scatter, bubble, point  

 Radar, polar  

 Gauge  

 Metrics range 

Choosing a Chart Type and Configuration: 

 To choose a chart type, consider what user wants the chart to illustrate. Different 

chart types and configurations emphasize different things. 

Purpose Chart type and configuration 

Show contributions of parts to a whole 
Pie, stacked  configuration 

100% stacked configuration 

Show trends in time or contrast values across  

different categories 

Line, area, bar, 

column 

Compare groups of related information  

against actual values 

Standard  configuration, 

Radar, 3D 

Compare different kinds of quantitative  

information 
column-line 

Figure 11: Sample Chart Report 
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Figure 12: Users Chart Report 

4)  Pie Charts: 

 Pie charts are useful for highlighting proportions. Pie charts use segments of a 

circle to show the relationship of parts to the Pie charts plot a single data series. 

5)  Column Charts: 

 Column charts are useful to compare discrete data or to show trends over time. 

Column charts use vertical data markers to compare individual values. 

 

 

Y-axis title 

Data series 
Sub title 

Title 

X-axis labels 

X-axis title Footer 



University of Hyderabad 42 IBM India Software Labs 

6)  Pareto Charts: 

 Pareto charts are useful for prioritizing and focusing process changes. Pareto 

charts rank categories from the most frequent to the least frequent. It is more effective to 

act on the most frequent causes of events than to solve an easy yet infrequent issue.  

7)  Bar Charts: 

 Bar charts are useful for showing trends over time and for charts that plot many 

data series. Bar charts use horizontal data markers to compare individual values. 

8)  Line Charts: 

 Line charts are useful for showing trends over time and for charts with many data 

series. Line charts plot data at regular points connected by lines. 

9)  Area Charts: 

 Area charts are useful for emphasizing the magnitude of change over time. Area 

charts are like line charts that have the areas below the lines filled with colors or patterns. 

10)  Radar Charts: 

 Radar charts are useful as a comparative tool and for charts with few data series. 

Radar charts integrate multiple axes into a single radial figure.  

11)  Scatter Charts: 

 Scatter charts use data points to plot two measures anywhere along a scale, not 

only at regular tick marks. 

12)  Bubble Charts: 

 Bubble charts use data points and bubbles to plot measures anywhere along a 

scale, like scatter charts. The size of the bubble represents a third measure. Bubble charts 

are useful for visually representing financial data.  
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13)  Point Charts: 

 Point charts are useful for showing quantitative data in an uncluttered fashion. 

Point charts use multiple points to plot data along an ordinal axis. A point chart is similar 

to a line chart without the lines.  

14)  Polar Charts: 

 Polar charts are useful for showing scientific data. Polar charts are circular charts 

that use values and angles to show information as polar coordinates. 

15)  Metrics Range Charts: 

 Metric range charts are useful for showing a target range and a tolerance range. A 

metric range chart adds a target and range marker to a column, line, or area chart. 

16)  Gauge Charts: 

 Gauge charts are useful for comparing values between a small number of 

variables either by using multiple needles on the same gauge or by using multiple gauges. 

Gauge charts use needles to show information as a reading on a dial. The value for each 

needle is easily read against the colored data range. 

4.1 Re-usability  

 Cognos provides re-usability with “Reuse Layout Object”. User can reuse the 

properties of a report to other report or user can use some components of the report or the 

entire report. 

Click the object that user want to reuse. 

1. In the Properties pane, in the Name property, type a value beginning with a letter 

to uniquely identify the object and press the Enter key. 

2. To reuse the object in another report, open that report. 
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3. In the Insertable Objects pane, on the Toolbox tab, drag the Layout Component 

Reference object to the location where user wants to reuse the object. 

4. In the Component Location box, do the following: 

5. Click This report to reference an object in the current report. 

6. Click Another report to reference an object in another report, click the ellipsis (...) 

button, and open the report user want. 

7. In the Available components to reference box, click the object user want and click 

OK. 

8. If the referenced object is in another report, click the Layout Component 

Reference object and in the Properties pane, click the Embed property and specify 

how to store the referenced object in the report: 

9. Click Copy to store a copy of the object. 

10. Click Reference to store a reference, or pointer, of the object. 

4.2 Sub Report 

Cognos provides sub reports functionality/facility with Drill through definition 

concept. Using drill-through access, user can move from one report to another Drill-

through access helps user to build business intelligence applications that are bigger than a 

single report. 

In Cognos 8, user can drill through 

 between reports created in different packages against different data source types 

 from one existing report to another report using Report Studio  

 between reports in Report Studio, Query Studio, or Analysis Studio, exploring 

data in many ways 

 from Metric Studio to other Cognos 8 reports by passing parameters using URLs 
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The drill-through object appears as a blue hyperlink in the report. 

Steps 

1. Open the target report. 

2. Create a parameter that will serve as the drill-through column or that will be used 

to filter the report. 

3. Open the source report. 

4. Click the element in the report that will serve as the drill-through object. 

5. Click the drill-through definitions button or from the Properties pane, double-

click the Drill-Through Definitions property. 

6. Click the new drill-through definition button. A drill-through definition is created. 

7. On the Target report tab, click the ellipsis (...) button next to the Report box, and 

select the drill-through target report. 

8. In the Action box, decide how the target report will be viewed when users click 

the drill-through column in the parent report: 

9. In the Display prompt pages box, decide whether to display prompt pages 

4.3 Prompts and Parameters 

 The prompt is the drop-down list of values, the parameter is a placeholder for the 

selected product type, and the parameter value is the specific product type that the user 

selects. Prompt is represented by the selectValue. Parameter is located in the 

filterExpression 

Parameters: 

 Parameters are used to control or guide the report execution. Parameters are the 

input values to a report. It is a way the user communicates with the report. User can pass 

parameters to reports through filters and prompts. These filters and prompts, prompts the 
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user to enter parameters to reports while the report is executing. Report takes these 

parameters and processes it and gives the information based on the parameter given by 

the user. Filter expression is to focus a report and minimize processing time by excluding 

unwanted data. 

Prompts: 

 Prompts are composed of three interrelated components.  

 Parameters, which are based on parameterized filters. These parameterized filters 

form the questions the report wants to ask users.  

 Prompt controls provide the user interface in which the questions are asked.  

 Parameter values provide the answers to the questions. 

 

Report Studio provides several ways to create prompts. User can 

 Define prompts using context filters 

 Use the Build Prompt Page tool 

 Build user own prompt and prompt page 

 Create a parameter to produce a prompt 

 Insert prompts directly into the report page 

a) Define Prompts Using Context Filters 

If context filters are already defined, use these filters to create prompts in the report. 

1. In the Context filter section of the overview area, click the down arrow next to the 

filter that user want to use as a prompt. 

2. Click Prompt. 

3. Do one of the following: 
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4. To remove the prompt, click No Prompt. 

5. To allow users who run the report to select any member from a tree of the 

hierarchy, click Prompt on Hierarchy. 

6. To allow users who run the report to select from a list of members from the 

current level, click Prompt on Level. 

b) Use the Build Prompt Page Tool: 

Use the Build Prompt Page tool to quickly add prompts to a report. 

1. Click the column user want users to be prompted on. 

      To create multiple prompts or a cascading prompt, click more than one column. 

2. From the Tools menu, click Build Prompt Page. 

c) Build Users Own Prompt and Prompt Page: 

1. Pause the pointer over the page explorer button and click Prompt Pages. 

2. In the Insertable Objects pane, on the Toolbox tab, drag Page to the Prompt 

Pages box. 

3. Double-click the page user just created. 

4. In the Insertable Objects pane, on the Toolbox tab, drag one of the prompt 

controls to the prompt page. 

d) Create a Parameter to Produce a Prompt: 

 Report Studio can automatically generate prompted reports based on parameters 

user create. 

1. From the Data menu, click Filters. 

2. On the Detail Filters tab, click the add button. 
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3. In the Available Components box, click the source or Data Items tab to select the 

data item user want to use for the prompt: 

4. In the Expression Definition box, type an operator after the data item, or select an 

operator from the Functions tab. 

5. Type a name after the operator to define the prompt parameter. A question mark 

must precede and follow the name. 

6. Click OK. 

7. In the Usage box, click one of the following 

8. To create a required prompt, click Required. 

9. To create an optional prompt, click Optional. 

10. To specify not to use the prompt, click Disabled. 

11. Click OK. 

e) Create a Prompt Directly in a Report Page: 

 User can add prompt controls directly in a report page instead of creating a 

prompt page.  

 In the Insertable Objects pane, on the Toolbox tab, drag a prompt control 

to the location where user wants it to appear. 

 Provide the information necessary to create the prompt. 

 In the work area, click the prompt. 

 In the Properties pane, set the Auto-Submit property to Yes. 

Modifying Prompts: 

User can modify prompt properties by specifying values in the Properties pane. User can, 

 change the prompt control interface 
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 specify that a prompt requires user input 

 allow users to select multiple values 

 show or hide prompt status 

 specify default selections 

 specify prompt values 

 add a prompt button 

 create a cascading prompt 

4.4 User defined formulas/expressions: 

 Cognos provides a wide variety of expression to work with data. An expression is 

any combination of operators, constants, functions, and other components that evaluates 

to a single value. A calculation is an expression that user use to create a new value from 

existing values contained within a data item. The expression editor shows the expression 

components that are supported by the data source in which the metadata is stored. 

 When building expressions in the expression editor, user can browse the data of a 

data item. This is useful when user do not know how a particular value is stored in the 

database. 

Operators: 

 Operators specify what happens to the values on either side of the operator. 

Operators are similar to functions, in that they manipulate data items and return a result. 

Summaries: 

 This list contains predefined functions that return either a single summary value 

for a group of related values or a different summary value for each instance of a group of 

related values. 
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Constants: 

 A constant is a fixed value that user can use in an expression. 

Constructs: 

A construct is a template that can be used to create an expression. 

Business Date/Time Functions: 

 Business functions for performing date and time calculations. 

Block Functions: 

 Functions used to access members of a set, usually in the context of Analysis 

Studio.  

Macro Functions: 

 These functions can be used within a macro. A macro may contain one or more 

macro functions.  

Report Functions: 

 Expressions created by using the objects of a report.  

 In addition to these Cognos uses some database specific functions for the 

databases like DB2, Informix, MS Access, Oracle, Red Brick, SQL Server, Teradata, 

SAP BW and Sybase. 

4.5 User defined styles to report controls: 

  Cognos allows a wide range of styles that user can apply to reports. 

Properties pane gives most of the styles that user can apply.  

Properties pane gives the following properties 

1. Conditional 
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2. Box 

3. Size and overflow 

4. Colour and background 

5. Text and font 

6. Positioning 

7. Miscellaneous styles  

In addition to these styles user can  

 group the data 

 create sections 

 create headers and footers 

 add tables 

 add user defined formulas or expressions 

 add filters 

 aggregate the values 

 add drill through access 

 build prompt pages  

  To set a style to a object, select the object and go to properties pane or set other 

styles given by the Cognos. 
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5 Merits and De-merits  

Merits 

 User can create different types of reports. 

 User can create reports in different output formats. 

 User can create a wide variety of chart reports. 

 User can create the filters in different ways. 

 User can traverse the package easily   

 User can connect to different types of databases 

 User can set different styles to reports easily 

De-merits 

 Here I am listing some problem which I observed while working with Cognos 

Report studio. 

 Problem 1:  In the charts it is difficult to distinguish the borders between the 

values if the entries (series values) are more.  

 Problem 2:  It is not easy to place an object where ever user wants in the report. It 

needs to do some work with margin and border and padding of the object. 

 Problem 3: There is no padding property (or option) for image object. 

 Problem 4:  user can’t place an object on another object. 

 Problem 5: There is no Line object. To draw a line user have use “Border” 

property. 

 Problem 6: Conditional styles do not working properly. 

 Problem 7: Some Report Functions are not working in report studio but working 

in                 Cognos Connection.  Ex. ReportName 
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6. IBM Cognos 8 Software Development Kit (SDK) 

 Cognos 8 SDK allows the user to manage Cognos 8 processes and implement 

custom reporting solutions. User can use the SDK to create and modify reports and 

queries, schedule and deploy reports and other objects, and administer Cognos 8 servers 

and security. The Cognos 8 BI software development kit (SDK) provides a single 

application programming interface (API) that delivers complete openness and the ability 

to access broad business intelligence functionality.  

 Install Cognos 8 SDK in the installation location of the Cognos 8 server.  

 Work with the SDK code to configure it to users working environment. 

 Create report with SDK code and Run report in java environment. 

 Create report that takes parameters and outputs required values. 

 Create an enterprise application that uses the above code which creates and runs 

the report with WebSphere Application Server.  

Changes made to the code 

1. in CRNConnect.java  change    

private String CRN_HOME = curDir.substring(0,curDir.lastIndexOf("sdk")-1); 

     to 

private String CRN_HOME = curDir.substring(0,curDir.lastIndexOf("sdk")+1); 

2. Because user are not using any action listerns take default values for 

 Package path for parent path in ReportObject.java 

 Columns names in addcolumns method of ReportObject.java  
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7. IBM Integration Services Framework (ISF) 

 The Integration Services Framework serves the purpose of developing and 

integrating the IBM products as a set of managed applications. It provides common 

facilities (the ISF common services) such as security, monitoring, logging, reporting - 

and more. It also provides a standard API level access to those services in a transport and 

language independent way, greatly facilitating the integration of the IBM Platform in an 

enterprise wide environment. 

 

ISF Applications 

 Model  

 Logging  

 Scheduling  

 Report  

 Web components  

 Agent handlers  

 Calling other apps  

 Security  

ISF Service 

 An ISF service is a software module for a specific business function. In the 

context of the ISF, the business function is one of the functions provided by the IBM 

platform. Typical examples are:  

 A logging service: a service to log messages.  
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 A job control service: a service to stop, start, schedule and examine log of         

DataStage jobs.  

 A job design service: a service to create and design DataStage jobs.  

 A data cleansing service.  

 A service provider is the entity creating and implementing a specific service. A 

service consumer is the entity calling (or invoking) a service. 

Developing with ISF 

 ISF and all the developed ISF applications are hosted in a J2EE application 

server. The currently supported application server is WebSphere 6.0.2.5. The   supported 

Java environment is IBM Java Runtime Environment 1.4.2. 

Implementing an ISF application is as follows: 

1. Define the service interface as a Java interface. 

2. Develop an EJB stateless or state full session bean implementing the service 

interface. 

3. Session bean remote interface must be completely empty. It must just extend the 

business interface. 

4. provide an ISF deployment descriptor 

5. package the session beans for the services in users application in a J2EE EAR file, 

and provide the ISF, J2EE and application server specific deployment descriptors 

6. Use the ISF deployment tools to deploy the EAR file for users application. 
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8. Service Oriented Architecture (SOA) 

 Install Service Oriented Architecture and configure it to user environment. 

 Create a service and deploy it in IBM Information server. 

 Create a Cognos service and integrate it with IBM Information server. 
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9. Conclusion and Future Work 

Conclusion 

IBM Cognos ReportNet is a Web-based reporting tool which can meet almost all 

the reporting requirements of the organization. It can generate many types of the reports 

in different formats. It can generate the reports from simple inventory lists to high 

volume billings. ReportNet can generate sophisticated, multiple-page, multiple-query 

reports against multiple databases. It is easy to work with ReportNet. It provides many 

options to change the contents of the reports. It provides many styles to apply the repots. 

It gives a good way to reuse the report objects and to create sub reports with the reports. 

User can easily communicate with the reports with prompts. User can apply own 

formulas and expressions to data in the reports. 

Future work 

IBM Cognos ReportNet is installed and configured and evaluated for different 

features like user defined options, user defined styles, and user defined formulas, re-

usability, subreports, and prompts. A service for Cognos ReportNet is created in SOA 

and given to IBM ISF team and they will forward it for integration with IBM Information 

Server. 
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IBM Cognos Report Studio

 First completely Web-based enterprise reporting solution.
 Address all reporting requirements of an organization.
 Fully integrated with score carding, dash boarding, analysis,

event management, query and reporting.
 Can develop reports from simple inventory lists to high-

volume billings.
 Can deliver many type of reports like lists, cross tabs, charts,

maps.
 Can create reports in many formats like html, pdf, Excel, csv,

xml.
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User Interfaces

Web based
1. Cognos Connection
2. Cognos Administration
3. Report Studio
4. Query Studio
5. Analysis Studio
6. Event Studio
7. Metric Studio

Window based
1. Framework Manager
2. Metric Designer
3. Transformer
4. Map Manager
5. Cognos 8 Go office
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Cognos Connection

 It provides a single access point to all data available in 

Cognos.

 User can use Cognos Connection to work with entries such 

as reports, analyses, queries, packages

 User can use Cognos Connection to create shortcuts, URLs, 

and pages, to organize entries.

 Go Cognos Connection
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Framework Manager

 It is the metadata tool used to model data

 Package provides the data items that we use in reports.

 Go Framework Manager
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Report Studio

Report Studio is a Web-based tool that is used to build
sophisticated, multiple-page, multiple-query reports against
multiple databases.
Report studio

 Report Go sample report sample report
 Report template Go

University of Hyderabad



107/15/2009

Building Cognos  Applications

 Database connections are created and are used for
modeling, for authoring and running the application.

 Reports are created in the report studio of Cognos .
 Deliver the content from the Cognos and view information

that has been saved and also run reports, analyses,
scorecards.

 workflow

Locate and prepare
Data sources 

Build and publish Build and publish 
contentcontent Deliver the InformationDeliver the Information
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Report Studio Features

 Re-usability
 Sub Reports
 Prompts/Parameters
 User defined formulas/expressions
 User defined Styles
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Re-usability

 Cognos provides reusability with “Reuse Layout Object”.
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Sub Report

 Cognos provides sub reports functionality by 
“Drill through definition” concept
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Prompts and Parameters

 Prompts are used to control or guide the report execution
 User can pass parameters to reports through prompts
 Report Studio provides several ways to create prompts.
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User defined formulas/expressions

 An expression is any combination of operators, constants,
functions, and other components that evaluates to a single
value.
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User defined styles 

 Cognos allows a wide range of styles that we can apply to
reports

 Properties pane gives most of the styles that we can apply.
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Merits

 different types of reports.
 reports in different output formats.
 a wide variety of chart reports.
 filters in different ways.
 traverse the package easily  
 connect to different types of databases
 set different styles to reports easily
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De-merits

 In charts it is difficult to distinguish the borders between the
values if the entries (series values) are more.

 It is not easy to place an object where ever we want in the
report. It needs to do some work with margin and border
and padding of the object.

 There is no Line object. To draw a line we have use
“Border” property.

 Some Report Functions are not working in report studio but
working in Cognos Connection.
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Cognos Software Development Kit 

 Install Cognos 8 SDK configure it to working environment.
 Create report with SDK code that takes parameters and

outputs required values. and Run report in java
environment.

 Create an enterprise application that uses the above code
which creates and runs the report with Websphere
Application Server.
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IBM ISF

 IBM Information Services Framework

 Developing and integrating the IBM products

 ISF common services are monitoring, logging, security
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IBM Service Oriented Architecture

 Install Service Oriented Architecture and configure it to
your environment

 Create a Cognos service and deploy it in IBM Information
Server

 Run the Cognos service from IBM Information Server
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Uses

 The user of Information Server can create reports for
logging, scheduling, and security services.

 The user can retrieve and view reports and schedule reports
to run at a specific time and frequency.

 Reports can be formatted as HTML, PDF, Excel,
Microsoft® Word documents.
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Report

 Creating a report is  actually creating a report specification
 The report specification defines the queries and prompts 

that are used to retrieve the data
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Report Template

 Its a “pattern used to build” reports
 Used when we frequently produce the same type of report
 It may contain HTML items, Hyperlinks, page numbers, 

images, tables, text items, blocks, layout calculations, date, 
time

 convert a report to a template or create a new template
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